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Model

302 Six Channel Data System

For SRI GC Control OR as Stand-alone independent 6-Channel Data System

•
•
•
•

6 channels, 4 separate time bases, 4 remote start inputs
Independent start & stop times for 4 separate instruments
USB 2.0 connection to your Windows™ PC
Includes PeakSimple software

The Model 302 is available mounted inside the 8610C, 8610D, 410, and 310 GCs, or it can be mounted in a separate
box for connection to other manufacturers' GC or HPLC detectors.
The Model 302 data system consists of PeakSimple chromatography software for Windows, and a six channel, 20-bit high
resolution A/D board.
When mounted in a SRI GC, the Model 302 controls the column oven temperature program, and the pressure program of the
carrier gas electronic pressure controller (EPC).
he eight available TTL outputs are connected internally within the GC to control functions like valve rotation, gas solenoid
actuation, autosampler injection, etc.
When mounted in a separate box, the temperature, pressure, and gradient control outputs are available for use, but not connected to anything.
The eight TTL outputs are wired to a bank of eight single-pole, dual-throw mechanical relays with screw terminals for easy
connection to any user device which operates from a contact closure.
Four remote start inputs allow run initiation from the user's GC or HPLC system.
Each of the six channels of data can be randomly assigned to one of four time bases, which allows independent start and stop
times for four separate instruments.
Data can be acquired at rates up to 50Hz per channel for one or two channels, or 20Hz for all six channels.
The Model 302 is for use with Windows computers that have USB 2.0 compliant ports.
8600-6055 Model 302 six channel USB data system USD3,180.00
8600-6255 Model 302, 230VAC USD3,180.00
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PeakSimple Data Systems
With 1, 4, or 6 Channels of Data Acquisition

For any WindowsTM computer
Standard in every SRI
GC and HPLC system

USB or serial port
Available as a stand alone unit

SRI’s PeakSimple Chromatography Data System is included with every SRI GC and HPLC
system, and is also available as a convenient stand-alone data system for any other manufacturer’s
GC or HPLC. PeakSimple software has been continuously developed, refined and improved since
1988 by the same dedicated team of working chromatographers who use the software on a daily
basis, and strive to simplify and enhance every aspect of PeakSimple so our customers will benefit.
New features are added to PeakSimple several times per year and the latest version is always
FREE to download online, along with helpful tutorials. Tech support at SRI is “old fashioned!”
When you call, a knowledgeable technician will answer your questions right away. No complicated
phone menus, and no waiting on hold!

Easy to Learn, Easy to Use Software
for all WindowsTM Computers
Most PeakSimple functions are launched
from the chromatogram window, and are
so user friendly that most operators can
produce results almost immediately.
ToolTips makes learning your way around
PeakSimple even easier—just hold your
mouse cursor over any icon or checkbox
to read the onscreen How-To instructions
in one of many available languages.
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PeakSimple for WindowsTM Software
TAKE A CLOSER LOOK AT YOUR DATA
PeakSimple gives
you two ways to closely
Zoomed area
examine
data
in
the
selection
chromatogram window. Click and
drag the mouse cursor to draw a
rectangle around the area you wish to
enlarge, and that area will expand to fill
the chromatogram window. This may
be done multiple times. Clicking on the
Unzoom
icon in the toolbar
unzooms one level at a time
until you return to the
A mouse click on one icon
vertically enlarges the peaks in the
original resolution.
chromatogram, decreasing the y-axis display limits by a factor of two. A click
on another icon
increases the y-axis display limits by a factor of two, which
vertically shrinks the chromatogram peaks.

CLICK & DRAG
RETENTION WINDOWS
Retention windows

MOVE

SHRINK

STRETCH

Retention window brackets are
visible onscreen, and may be
grabbed, dragged onto a peak,
widened, or narrowed.
The
component table is automatically
updated when a retention
window is graphically
moved or modified.

MANUAL INTEGRATION
Manual integration tools permit you to refine the
integration method applied to any peak. The manual
integration toolbox is available at a click of the
mouse. Baseline projection may be “rubberbanded” from point to point, forced to a valley,
dropped vertically, skimmed, etc.

The Manual Integration toolbox may be placed above
(as shown at right) or to the left of the chromatogram
window. It may also be dragged “off” the
chromatogram window to float as an independent,
move-able window.
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Easy to Learn, Easy to Use
OVERLAY CHROMATOGRAMS
Overlay the data in any channel onto any
other channel for retention time
comparison or multi-detector correlation.

The Overlay Adjust feature lets you
stretch and shift overlaid data to facilitate
pattern matching.

BASELINE SUBTRACTION and DATA SMOOTHING
Blank baseline subtraction is useful to
compensate for baseline drifting due to
column bleed and temperature ramping.
PeakSimple lets you subtract baselines in
real time as data is collected or post run.
Noisy
detector
signals can be smoothed
manually or automatically
at the end of a run.
Smoothing algorithms
include
Olympian,
Moving Average, and
Savitsky-Golay.

CALIBRATION
Multi-Level Calibration Curves
Calibrate peaks six ways (multi-line, quadratic,
parabolic, etc.) using single or averaged data at up
to seven concentration levels. Statistics for
evaluating line fit quality, modification date audit trail,
and curve printout help to ensure defensible results.

Calibration Averaging
PeakSimple allows up to three replicate calibration
standards at seven levels of concentration to be averaged
when constructing calibration curves.
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PeakSimple for WindowsTM Software
CHANNEL DETAILS
Each channel has a Channel details dialog box which allows
users to set parameters for that particular channel. From the
Channel details dialog box, you can set your sampling rate
and default millivolt display limits; choose temperature,
pressure, or gradient control; subtract the baseline from
another channel; overlay the data from another channel; turn
Data-logger mode ON or OFF; designate a start time to
compensate for relative retention shifts, and more.

CONTRO

TEMPERATURE PROGRAMMING

Eliminate the need to repeat
simply by opening a control fil
Maximize reproducibility—it do
chromatograph because the control
parameters. Save any change you make
postrun actions, even color choices, to a co
a control file for each method of analysis that
control files you can have is limited only by yo

EPC & HPLC GRADIENT PROGRAMMING
“Temperature,” “Pressure,” and “Gradient” channel control
options all use the same simple dialog box, and each may be
programmed with unlimited ramps and holds. Program one
or two SRI GC column ovens from ambient to 400oC with
0.01 degree resolution and negative programming. Program
the carrier gas pressure on SRI GCs equipped with electronic
pressure control. Form binary HPLC gradients for low-cost
pump control.

MANUAL/AUTOMATIC
EXTERNAL EVENT CONTROL
In addition to performing timed
integration events, control up to eight
external contact closure relay outputs
to actuate sampling valves,
autosamplers, solenoids, pumps, or
any external device using TTL or relay
contact closure triggers.
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Easy to Learn, Easy to Use
INTEGRATION
Use the Integration button to determine how PeakSimple integrates
the data peaks in the chromatogram. Set peak detection
sensitivity, area reject and standard weight. Specify a spike
channel, merge results from another channel, and correct for
sample weight and dilution.

OL FILES

tedly specify run parameters
e before beginning an analysis.
esn’t matter who is operating the
l files contain all the necessary run
e in the analysis, from channel details to
ntrol file and use it again and again. Create
t your lab typically performs. The number of
our disk space.

COMPONENTS
Create, save and edit
component tables with an
unlimited number of
compounds.
Enter
expected retention times,
control peak display, and
more! Component details
may be viewed and edited
by double-clicking on any
retention
window
in
the
chromatogram. Or, open the
Component table and double click on
any component in the list to view or
edit that component’s details.

POSTRUN
PeakSimple can perform a variety of postrun actions to help you
maintain and organize your data. Specify how data will be saved,
and automatically add the results of the run to the results log for
that channel. You can set PeakSimple to automatically print the
results at the end of a run, and update your DDE link. Execute a
command, specify a recalibration level, and restart the run after a
given amount of time. You can even have PeakSimple smooth the
data before copying it into another channel.
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PeakSimple for WindowsTM Software

DYNAMIC DATA EXCHANGE
Link PeakSimple to your DDE compatible
spreadsheet or word processor (Excel,
Word, 123, etc.). Anaytical results are
automatically transferred after every run,
or can be accumulated within
PeakSimple and copied as a block of
data. Use the Copy Picture option to
paste the chromatogram itself into Excel,
etc. along with the results.

MERGE RESULTS FROM
MULTIPLE CHANNELS
PeakSimple lets you merge
the results from any channel
or all channels into one
report. This feature is handy
when you’re combining
results from different
detectors into a single report
for export to Excel or other
data analysis programs.

PRINT CHROMATOGRAMS IN COLOR

Use any WindowsTM supported color printer to create
impressive hardcopies of your chromatographic data.
Print multiple chromatograms per page for easy detector-to-detector comparisons and paperwork
consolidation. Print overlaid data in contrasting colors with adjustable line weight.
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Easy to Learn, Easy to Use
AUTOSAMPLER QUEUE
and
BATCH REPROCESSING
Create customized autosampler
sequences for liquid injections, purge
and trap autosamplers, gas sampling
valves, and stream selectors including
unique predefined sample information,
auto-calibration
and
batch
reprocessing of previously run
samples.

DATA LOGGER MODE
Peak Simple’s Data Logger
Mode allows you to display
a scaled and calibrated
result in large numbers
instead of the usual strip
chart data presentation.
Data Logger Mode is
especially useful when
monitoring
total
hydrocarbons on one
channel while performing a
separation on another
channel.

SELF-VALIDATING
HARDWARE
PeakSimple will play back and reacquire any chromatogram multiple
times, establishing the precision and
accuracy of the data system using
real
data,
not
“canned”
chromatograms. PeakSimple’s
validation can be performed by the
user anytime without extra hardware.
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SRI PeakSimple Data Systems
Serial Port
Models 202 and 203 connect to your computer with a serial port cable. WindowsTM computers with
two available serial ports can operate dual 203 systems, a 202 and 203 together, or dual 202 systems for
a total of up to eight data channels and four time bases. Temperature and pressure control outputs are
available for connection to a GC or HPLC. PeakSimple software works with each of the following hardware
options, serial or USB port, and is included with each unit.
Model 203 has one channel capable of acquiring data at up to
50Hz. Its eight TTL outputs can be optionally wired to a bank of eight
single-pole, dual-throw mechanical relays with screw terminals for easy
connection to any user device which operates from a contact closure.
A remote start input allows run initiation from the user’s GC or HPLC
system. The 220VAC system is supplied with a UL, CSA, and CE/
VDE approved universal voltage input which will operate on any 100250 volt power supply.

Model 202 has four channels. Data can be acquired at up to 50Hz
with one channel active, 10Hz with two channels, or 5Hz with all four
channels activated. The four channels of data can be randomly
assigned to one of two time bases to allow independent start and stop
times for two entirely separate instruments. Two remote start inputs
allow run initiation from the user’s GC or HPLC system. Model 202
includes the bank of eight single-pole, dual-throw mechanical relays
with screw terminals for easy connection to any device that operates
from a contact closure.

Model 203

Approximately 8” wide x
8” deep x 1.75” high

Model 202

Approximately 15” wide x
11” deep x 2” high

USB
Model 302 is for analysts who prefer the hot-swappable, plugand-play capabilities of Universal Serial Bus devices. Four remote
start inputs allow run initiation from the user’s GC or HPLC system.
The six channels of data can be randomly assigned to one of four time
bases which provides independent start and stop times for 4 entirely
separate instruments. Data can be acquired at up to 50Hz per channel
with 4 channels active, and up to 20Hz with all 6 channels activated
and acquiring data. The Plug and Play peripheral connection of choice,
USB is supported by Microsoft Windows 98, 98SE, ME, XP, and 2000.
8600-1055
8600-1255
8600-4055
8600-4255
8600-6055
8600-6255
SRI Instruments

Model 302

The Model 302 chassis
is the same as the 202.

Model 203 Single Channel Data System with PeakSimple software
Model 203 220VAC
Model 202 Four Channel Data System with PeakSimple software
Model 202 220VAC
Model 302 Six Channel USB Data System with PeakSimple software
Model 302 220VAC
310-214-5092

Fax 310-214-5097

20720 Earl St. Torrance, CA 90503

$ 1,395.00
$ 1,495.00
$ 2,395.00
$ 2,395.00
$ 2,595.00
$ 2,595.00
www.srigc.com
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Model 302 Six Channel USB
Chromatography Data System Quick Start Tutorial
The Model 302 comes with a two meter
USB cable, power cord, ( may be either
120 or 220 volt ) and a PeakSimple software disk. PeakSimple software may also
be downloaded from www.srigc.com. Its
a good idea to check the website in case a
more recent software version has been
released.
If the 302 A/D board is installed in a SRI GC
rather than in a stand-alone box as shown
then plug the USB cable into the right side of
the GC. Also, if the 302 is installed in an SRI
GC then all of the hardware connections will
have been made already, you just have to install the software.

Plug the power cord from the 302 box into
the mains wall socket and turn on the
power switch located on the back of the
stand-alone box. Plug the USB cable into
the 302 box.
Wait until PeakSimple software is
already installed before plugging the USB
cable into your computer.
Install PeakSimple software from the CD
disk or from the file downloaded from
SRI’s website. Browse to the CD or to the
downloaded file on your hard-drive ( C:\ ) .
The file’s name will be setup354 if it is version 3.54 of PeakSimple and setup356 if
the PeakSimple version number is 3.56.
PeakSimple is updated every few months
usually to add a new feature.
Install PeakSimple in the suggested folder
( C:\peak354 ) unless you have a very
good reason to choose another.
Using the typical folder name helps simplify the tech support process.

Page 1
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Model 302 Six Channel USB
Chromatography Data System Quick Start Tutorial
When you click “Next” the PeakSimple
software will be installed and you will
see the screen to the right.
Click “Finish”
Now connect the USB cable to your
computer.
A hardware
“Wizard” will
appear to
help you install the USB
driver. The
example
shown is for a Vista operating system.
For XP computers the “wizard”
screens will be slightly different.
Follow the screens as shown
At the end of the process you can
verify that the driver was installed
by looking at the “Device Manager”
screen in the “Control Panel”

Browse at this point
to the PeakSimple
folder ( c:\peak354 )
Since this is where
the driver file is
located.

Under the Universal
Serial Bus Controllers
See Lawson Labs
listed

Select
Install Anyway

Page 2
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Model 302 Six Channel USB
Chromatography Data System Quick Start Tutorial

Click on the PeakSimple icon ( which will
be somewhere on the Windows Desktop
screen ) to launch PeakSimple.

This warning will appear, but
click “Run “ anyway.
You can un-check this box to avoid this
message in the future.

The PeakSimple
screen will look like
this.

Page 3
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Model 302 Six Channel USB
Chromatography Data System Quick Start Tutorial

Use your mouse to click on “Edit” and
then “Overall…”

In the “Overall… “ screen enter the
“Board Type” ( 302 ) and then the “USB
device number”.

The USB device number is a unique
number which identifies this particular
302 board. Because each 302 board
has a unique number you can operate
several of them independently on one
single computer . The USB device number is printed on the back of the 302 box
and also on the USB controller chip on
the 302 board.
On a GC the
device I.D.# is
printed next to
the USB jack
on the side on
the instrument.

When you click “OK” you will see a box
on the top left of the screen which displays the calibration conversation PeakSimple has with the Model 302 board.

Page 4
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Model 302 Six Channel USB
Chromatography Data System Quick Start Tutorial

Use your mouse to click on “Edit” and then
“Channels” or just click on the “Channels Icon”
which looks like the numbers 1,2,3,4.

In the “Channels” screen verify that the
“Active” checkbox for channel 1 is
checked.
Then click “OK” to get back to
the main screen.
If PeakSimple has successfully established communication with the 302 board, then
the word “ STAND BY” will appear on the top right of the
screen with the detector signal
value ( in millivolts mV ) just to
the right. In the example to
the right the signal is 212.693 millivolts.
This number will change slightly every
second because of the system noise.
Click “File” and then “Save All” or just
click the icon which looks like a stack
of floppy disks to save everything you
have entered so far. If you forget to
do this you will have to
repeat some of the information you have entered
like the USB device ID.#
next time you launch
PeakSimple. Click Save All anytime you
make changes to ensure PeakSimple remembers your changes.

Page 5
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Model 302 Six Channel USB
Chromatography Data System Quick Start Tutorial
Connect the detector signals to
the 302 board using the terminals
labeled In+ and InThere are 6 sets of
in+ and in– screw
terminals

Run the wires
through the cutout on
the rear of the box,

Connect the TTL
outputs to your system to control various
functions.
The 8 TTL outputs
are pre-wired to eight
corresponding mechanical relays on the
302’s companion
board,

Choose the
“Integrator”,
“Computer” or
“Chart Recorder”
output from your
system. On
attenuation 1, the “
Chart Recorder” output is the same as
the “ Integrator” or “Computer” output.
Connect the “Remote Start” output from
your instrument to the “in#1” ( remote
start ) and G ( ground ) terminals on the
302 companion board. This step is
OPTIONAL, you do not have to use
the Remote Start feature..
Connect the TTL ( relay ) outputs to your
system. For example, if you wanted to
actuate a Valco valve on your GC you
could use the TTL outputs to trigger the
valve. You may use either the TTL ( 0-5
volts DC) outputs located on the A/D
board or any of the eight pre-wired mechanical relays located on the companion board, Each mechanical relay has a
common ( C ), normally open ( NO ) and
normally closed ( NC ) screw terminal.
This step is also OPTIONAL, you do
not have to use the TTL ( relay ) outputs..

Page 6
15 (of 85 ) 2006-Update

16

Model 302 Six Channel USB
Chromatography Data System Quick Start Tutorial

Press the “Spacebar” on your computer’s keyboard to start the Run. ( there
are several ways to start the run including a “Remote Start” ). The word
“ Stand By “ will change to “Running”
and the data line will be drawn on the
strip-chart area of the main screen.

The horizontal lines
in the middle of the
screen are the
“Retention Windows”
which is how the
peaks are identified

Click the Auto-Zero button to bring the
signal down to 0.00 millivolts ( there are
several ways to auto-zero the signal including an “Event” in the Event Table
which auto-zeros the signal automatically at the beginning of the Run ).
Auto-Zero button

You can enter an
“ Event” to auto-zero the
signal automatically in
the Event screen.

The + and- buttons
control the y-axis
display limits

The “ Run “ will end at the time specified
in the Channel Details screen
unless you end it earlier by depressing
the “ End “ key on the keyboard.
For more information download the
PeakSimple tutorials on www.srigc.com
or call SRI Tech Support at 310-2145092

Page 7
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Model 302
Six Channel USB PeakSimple Data System
The Model 302 may be used with any brand or model of GC or HPLC offering an analog detector
output signal ranging from -5V to +5V. It includes three independent, programmable controls (0V to +5V
analog output) for temperature & pressure or HPLC gradient formation. The Model 302 has six channels,
which can be randomly assigned to one of four time bases, which allows independent start and stop times for
four separate instruments. Four remote start inputs compatible with 2-wire switch closures (typically output by
GCs and HPLCs as a remote start signal) are also included for your use. Two pulse stretchers are provided to
accommodate intstruments with remote start signals shorter than one second (such as Hewlett Packard GCs).
The computer to which you connect the Model 302 must support USB (it must have at least one USB
port—rev 2.0 or higher—and use WindowsTM 98, 98SE, ME, 2000, XP or newer).

With your purchase of the Model 302, you should receive the following items:
1 - Model 302 Data System box (front and rear views shown below)
2 - USB cable for connection to your computer’s USB port
3 - Manual (either the PeakSimple Chromatography Data Systems or
the SRI general product manual)
4 - PeakSimple for WindowsTM software (inside the manual cover)
The Model 302 comes in a sturdy
aluminum box consisting of top and bottom
halves, secured together with two brass
thumbscrews for easy interior access.
The brass thumbscrews are on the left- and
right-hand panels of the Model 302 box.

Front View

POWER Indicator LED

Rear View
Opening for analog signal cable(s)
and remote start device connections

USB connector

Breaker

POWER switch

Power cord
17 (of 85 ) 2006-Update

18

Model 302
Six Channel USB PeakSimple Data System
1. Open the Model 302
Verify that the Model 302 is powered OFF and unplugged. Remove the thumbscrews
on both sides of the Model 302 box and slide the top cover up and off. It is
connected to the bottom of the box by a ground wire, so just set it next to the
bottom half of the box.
High voltage
aluminum
safety cover

Power Supply board

A/D board

The Model 302 box contains two circuit
boards. The board on the right-hand side
is the A/D board. The board on the lefthand side under the removable high voltage
aluminum safety cover is the Power Supply
board. If you need to remove the high
voltage aluminum safety cover,
ALWAYS unplug the Model 302 from
the wall power outlet first (you do not
need to remove it for the wiring
connections described here).

2. Connect the Analog Signal Cable(s)
NOTE: The analog output from some GCs and LCs can have a range of up to 10 volts DC. The Model 302
can tolerate this voltage input, but signals above 6 volts will generate unwanted noise and signals above 5 volts
will be “clipped” (the tops of the waveforms will be cut off). Use the 1 volt output typically available on the
back of your instrument.
2-1. Route the analog signal cables from your instrument through the open hole in the back of the Model 302.
2-2. Strip 1/4” of insulation from the
“signal+” and “signal-” wires of your
instrument’s signal cables.
2-3. Remove any jumpers placed in the
Channels 1-6 screw terminals at the factory.
Insert the “signal+” wire into the A/D board
screw terminal marked “1 +” and secure the
connection with a small flat-blade
screwdriver.
2-4. Insert the “signal-” wire into the A/D
board screw terminal marked “1 -” and
secure the connection.
2-5. Repeat the connection of signal cables
for channels 2, 3, 4, 5, and 6. Any unused
channels MUST have both inputs jumpered
to ground.
Channels 1-6 and GD (ground) screw terminals
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Model 302
Six Channel USB PeakSimple Data System

The remote start wires for the first two
instruments are inserted into these screw
terminals on the Power Supply board.

3-6. The screw terminals for the third and
fourth instruments’ remote starts are on the
A/D board. The bank of screw terminals is
labeled “DIGITAL IN” under “1 2 3 4.”
Connect the “+” wires for the third and fourth
instruments to screw terminals 3 and 4,
respectively. Connect both “-” wires to the
“GD” screw terminal next to the “4” screw
terminal (on the right-hand side).
NOTE: TIMBASES 3 and 4 require a
remote start signal that persists longer for than
one second. Check your instruments’
specifications (for example, Hewlett Packard
GCs produce a very short remote start pulse,
so you should connect one of these to
TIMEBASE 1 or 2, which are equipped with
pulse stretchers).

3. Connect the Remote Start Cables (OPTIONAL)
The Model 302 remote start capability allows you to start the
data system by means of a switch closure. Four separate remote
start circuits permit the user to individually start TIMEBASE 1,
2, 3, and 4 of the data system. In some applications, the
chromatograph being used with the Model 302 may offer a
remote start signal output or switch closure output that permits
starting an integrator or other device when the START button
is pressed on the chromatograph’s on-board control panel.
Typically, this signal can be used to start the Model 302.
TIMBASES 1 and 2 are equipped with pulse stretchers.
3-1. Route the remote start cable from your instrument through
the open hole in the back of the Model 302.
3-2. Strip 1/4” of insulation from the “+” and “-” wires of your
remote start cable(s).
3-3. Insert the “+” wire into the Power Supply board screw
terminal marked “#1 IN” and secure the connection.
3-4. Insert the “-” wire into the Power Supply board screw
terminal marked “#1 G” and secure the connection.
3-5. For a second instrument, insert the “+” wire into the “#2
IN” terminal, and the “-” wire into the “#2 G” terminal.

1 2 3 4 GD

Connect the remote start “+” cables to screw terminals “3” & “4,”
and the “-” cables to “GD”.
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Model 302
Six Channel USB PeakSimple Data System
4. Connect the External Event Relay Wires (OPTIONAL)
The Model 302 has eight 0-5 volt TTL level outputs that are wired to a bank of mechanical relays with screw
terminals for easy connection to any device which may be operated from a contact closure (normally open
[NO] and normally closed [NC] contact closures). These relays may be turned ON and OFF individually and
automatically through a PeakSimple timed event table. Manual control is also available via the computer
keyboard.
Connect your devices to the A-H Relay screw terminals

4-1. Route the external event wires from your instrument
through the open hole in the back of the model 302.
4-2. Strip 1/4” of insulation off of each wire.
4-3. Select which device should be connected to each
event (“A” through “H”), then insert the wire into the
appropriate screw terminal on the Power Supply board,
and secure the connection. Make and keep a list of each
device you connect and the Relay it is connected to for
your reference (you will need this information to activate
the devices automatically with an event table or manually
with the mouse).

5. Replace the cover on the Model 302 and secure it with the thumbscrews.
6. Connect the USB Cable to Your Computer
The Model 302 is equipped with a
USB connector. A USB cable
(provided) connects the Model 302
to your WindowsTM computer’s USB
port. This plug and play interface
USB cable
permits the Model 302 to be loaded
onto and operated from a desktop or
laptop computer that supports USB
(rev. 2.0 or higher).
6-1. Secure one end of the USB cable
to an available USB port on your PC.
6-2. Secure the other end to the USB
connector on the back of the Model
USB port
302.
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Model 302
Six Channel USB PeakSimple Data System
7. Connect Power to the Model 302
The Model 302 is provided with a power cord which
plugs into a standard 110 (or 220) volt outlet. Plug the
Model 302 into the wall outlet. Turn ON the power switch
and verify that the POWER LED on the front of the Model
302 is lit.

The power LED is lit when the Model 302 is
connected to a power source & switched ON.

8. Install PeakSimple Chromatography Software
8-1. Locate your copy of PeakSimple, which is shipped inside the front
cover of your manual. Insert the CD or floppy disk(s) into your computer’s
appropriate drive.

8-2. Open the appropriate drive through My Computer, then double
click on “Setup.exe” and follow the instructions. By default, the
setup program places the PeakSimple application directory on the
hard drive: c:\peak2000. If you put the application directory
elsewhere, take note of the path as you may have to enter it in a
dialog box during the USB driver installation procedure.

9. Install the USB Drivers
There are three important files saved to the PeakSimple application
directory at the conclusion of the software installation: LL_USB.inf,
LL_USB.sys, and LL_USB2K.sys. These files are required for
Windows to recognize the A/D board connected to the computer’s
USB port.
9-1. Double-click on the My Computer icon on your desktop, then
on Control Panel, then on Add New Hardware, which should open
the Add New Hardware Wizard.
9-2. Click the Next button twice, until you get to the screen that
gives you a choice between letting Windows find the new hardware,
or selecting it yourself from a list. Click the radio button to choose
the hardware from a list and click the Next button.
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Model 302
Six Channel USB PeakSimple Data System
9-3. Scroll down the
hardware list, click on
Universal Serial Bus
controllers, then click
Next .
From the

following screen click
the Have Disk button.

9-4. Click Browse and navigate to the PeakSimple application
directory, or type in the path (“c:\peak2000” or the name you
have chosen). The Wizard should find the LL_USB.inf file. When
you click OK, the Wizard will verify that you want to copy files
from the PeakSimple directory (“Copy manufacturer’s files from:
c:\peak2000”).
9-5. When you click
OK again, the Wizard
will confirm that the
drivers are for Lawson
Labs. Click Next on
this screen and the
following screen, and
Windows will finish
installing the software
for the Model 302.
Click Finish.
9-6. Restart your computer (you MUST restart your computer
before the drivers will work). Open the Control Panel again, then
System, then click on the Device Manager tab. If the USB drivers
have been successfully installed, the Universal Serial Bus controllers
section will list “Lawson Labs, Inc. USB Data Acquisition
HdwrVer-04.”
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10. Launch PeakSimple

10-1. Double-click on the PeakSimple icon to launch the program. Verify that
communication has been established between your computer and the Model 302.
An error message will appear if communication is not established. This is normal
until you complete the following step.
10-2. Each SRI USB data system has a
unique 4-digit USB device number
beginning with “5” (5031, 5032, etc.).
This I.D. number is printed on the back
of your Model 302, and on your
PeakSimple disk. Open the PeakSimple
Edit menu and choose Overall. Enter
your Model 302 I.D. number in the box
labeled “Com port / USB device number.”
Click OK, and PeakSimple will attempt
to “wake-up” the data system. Click the
Save All

icon so you don’t have to

re-enter the USB device number.
Enter the 4-digit USB device number here

10-3. For the remote start option:
Open the Edit menu and choose Channels. Click on
the Details button for channel 1. Verify that Remote
start is enabled (the box should be checked). Repeat
this step for channels 2-6 if necessary.

10-4. For information about using Event tables, manual Relay activation, etc., see the “PeakSimple Tutorials”
and the “PeakSimple Software” sections in the manual (and online at www.srigc.com—click on the “Download
Our Documents” button on the homepage).
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11. Starting an Analysis
10-1. The upper right corner of the PeakSimple chromatogram window contains real-time information pertinent
to your analysis in progress. The status of the run (STAND BY, RUN) is displayed in capital letters next to the
millivolt (mV) reading, underneath the amount of time into the run.

11-2. Hit your computer keyboard spacebar to begin the run, and the data is plotted onscreen in the
chromatogram window.

Press the spacebar to begin the run

Press the End key
to stop the run

11-3. Hit the End key on your computer keyboard to stop the run.
Technical Support:
If you have questions or problems, call SRI for free technical support at 310-214-5092, 8am - 5pm California
time.
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Installing PeakSimple from the CD or USB
thumb drive:
A. Start the Windows operating system in use
on your computer. (Windows XP, Vista, or 7)
B. Insert the CD or USB thumb drive into the
computer.
C. Open My Computer and open either
the CD or thumb drive.

Installing PeakSimple from software download:
A. Start the Windows operating system and use an
online browser to access www.srigc.com.
B. From the menu on the left hand side of the
screen select Download PeakSimple and then
download the latest version. Windows XP and
some Vista computers need to download the 32bit version, other Vista computers and Windows
7 need to download the 64-bit version. If you are
unsure, right-click on My Computer then select
Properties in order to determine what bit operating system you are using.

D. Double-click on the Setup.exe file. Make
sure to select the right version of PeakSimple to install (32– or 64-bit). Windows XP
and some Vista computers need to install
C. Save the file to a temporary folder and doublethe 32-bit version, other Vista computers and
click on the setup file when it is finished
downloading, or, just click Run to install PeakWindows 7 need to install the 64-bit version.
If you are unsure, right-click on My ComSimple without saving the setup file.
puter then select Properties in order to determine what bit operating system you are
D. Follow the onscreen instructions provided by the
using.
installation wizard.
E. To complete installation follow the onscreen
instructions provided by the installation wizard.

E. For instructions on loading the driver, please
refer to the Quick Start Document located in the
PeakSimple folder or on the www.srigc.com
website.

F. For instructions on loading the driver, please
refer to the Quick Start Documents located
in the PeakSimple folder or on the
www.srigc.com website.
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Launching PeakSimple
1. Double-click on the Desktop PeakSimple icon to launch PeakSimple.
2. The data acquisition system will attempt to initiate communications between the computer and the data
system.
3. If PeakSimple comes up with an
error message stating “Acquisition
system is not functioning” with a
countdown timer, it is indicating
that there is a communication problem between the computer and the
data system or that the data system and the hardware is not connected. Click OK to continue working with PeakSimple.
4. The first time PeakSimple connects
to a GC or data system open the
Edit menu and select Overall to get
to the Overall Controls Screen.
5. Enter the proper Board type (202,
203, 302, or 333) and COM Port/
USB device number (Found on data
system or GC). Select OK and PeakSimple will establish communications
with the data system.
6. Most of the commands and options
in PeakSimple are equipped with tool
tips that will automatically pop up to
display useful information when the
mouse cursor is held over a command. To turn off the tool
tips deselect the tool tips
option in the Help menu.
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Opening a PeakSimple Data File
1. To open a PeakSimple data file or
chromatogram, begin by selecting File
in the PeakSimple menu bar and then
choose Open… from the set of options.
2. The Load Chromatogram File window
is now open. The PeakSimple software includes a number of sample
chromatogram data files that can be
opened, displayed, and manipulated.
One file, 602.CHR, will be used
throughout the rest of the tutorial. Select file 602.CHR from the PeakSimple directory, choose Channel 1 as a
destination channel, and then select
Open to load the file.
Adjusting Display Limits
1. To adjust the display limits of a
chromatogram click on either
the + magnifying glass icon or
the - magnifying glass icon to
the left of the chromatogram.
This will increase or decrease
the limits by a factor of two each
time you click on the icons.
2. After opening chromatogram
602.CHR, practice making the display limits smaller but the peaks larger by clicking the + magnifying
glass icon.
3. Practice making the display limits larger but the peaks smaller by clicking
on the - magnifying glass icon.

www.srigc.com
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Zooming
1. To zoom in on a specific part of a
PeakSimple chromatogram, click and
hold the left mouse button and drag it
over the desired area.
2. After opening chromatogram
602.CHR hold the left mouse button
and drag it over the base of the toluene peak. Let go of the mouse button
and there will be a larger view of the
area that was selected.
3. To return to the original display limits
of the chromatogram and unzoom the
area selected press F6 or select the
unzoom icon located in the PeakSimple toolbar at the top of the screen or
right-click and select Unzoom.
Dragging Retention Windows
1. To drag a retention window bar place
the mouse cursor on the bar until a
double sided arrow pops up. Click on
the left mouse button and hold and
then drag the retention window bar to
its desired place.
2. After opening the chromatogram
602.CHR zoom in on the benzene
peak and the smaller peak to its left.
Locate the benzene retention window
bar and drag it over to the smaller unnamed peak to the left of the benzene. Because this is a small peak it
is not immediately recognized.
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3. Right click on the chromatogram over
the unnamed peak and select Integration from the resulting menu.
4. From the integration window locate
the Area Reject dialogue box, erase
the 100.0 in the box, and add the
number 1.0 to the dialogue box. Click
OK and the integration window will
exit.
5. Press the Enter or Return key on
your keyboard and the smaller peak
will now be recognized as Benzene.

Manual Integration
1. To manually adjust the integration
baseline and peak separation in a
chromatogram use the manual integration toolbar provided by PeakSimple. To open up the manual integration toolbar select Edit in the PeakSimple menu bar and then click
on the Manual Integration option.
The manual integration toolbar will
now appear to the left of the chromatograph.
2. The manual integration toolbar
contains nine types of manual integration options. Four of the most
commonly used options are None
integration, Drop integration,
Based integration, and Rubber
Band integration.
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3. To make a baseline “ignore” a peak
use the None integration tool. After
opening chromatogram 602.CHR and
the manual integration toolbar, zoom
in on the baseline of the solvent peak
and the smaller unrecognized peak
immediately to its right. Click on the
None integration tool in the manual
integration toolbar with the mouse cursor and then click on the valley between the two peaks where they meet
the baseline. The area of the small
peak is now added to the solvent
peak.
4. To undo the changes made to a chromatogram at any time simply click on
the Undo integration tool in the manual integration toolbar. After selecting
this tool all integration changes made
to the chromatogram will be undone.
5. Click on the Undo tool with your
mouse cursor and select the Drop integration tool to enable the dropping
of the baseline below the two peaks.
After selecting the Drop tool click
where the valley of the peaks meet
the baseline with the cursor. The
baseline should now be dropped below the base of the peaks and a line
should extend from it to the baseline.
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6. After the manual integration between
the two peaks is dropped use the
Based integration tool to raise the
baseline to the valley between the
peaks. Once the Based integration
tool is selected, click on the valley between the solvent peak and the
smaller peak to its right with the
mouse cursor. The baseline will now
extend up to meet the valley of the
two peaks.
7. Once again click on the Undo tool in
the manual integration toolbar to remove all changes done to the chromatogram. Select the Rubber Band integration tool to manually draw a baseline. Once the Rubber Band tool is selected take the mouse cursor and click
on a part of the baseline. While holding down the left mouse button extend
the line to another part of the baseline
further to the right of the starting point
and let go of the mouse button. The
base line will now be drawn according
to the line that was drawn using the
Rubber Band integration tool.
Calibration
1. To turn the raw area of a peak into a
real-world number the peak first
needs to be calibrated. To calibrate
the Toluene peak in chromatogram
602.CHR, open up the file and then
right click using the mouse on the
Toluene peak. After right clicking on
Toluene select Calibrate Toluene
from the resulting menu.
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2. From the Recalibration level window
click on the first level radio button 1
(100.000) and then select OK with
your mouse cursor.
3. After selecting OK from the Recalibration level menu the Calibration menu
for Toluene will pop up. Check to
make sure the flashing asterisk on the
calibration curve is on level 1 and then
click on the Accept New button to the
right of the window.
4. Once the new data is accepted, click
on the Method button immediately
below the Accept New button. The
Recalibration type window will now
open allowing the user to select a
method of calibration. By default the
calibration type is set at Multiple Line
Segments. Select the Single line
through origin (Ax) radio button and
then click on OK with the mouse cursor.
5. After changing the method of calibration click on Statistics in the upper
right hand corner of the Calibration
level window. The Calibration statistics window will pop up revealing the
statistics for the calibration of Toluene. Click OK with the mouse cursor
to close the Calibration statistics window and then select Close from the
Calibration window to finish calibrating
Toluene.
6. View the calibrated results in the Results screen by right-clicking on the
chromatogram and selecting Results.
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Overlay
1. To compare two or more chromatograms overlay them using PeakSimple. To overlay two chromatograms first
open chromatogram 602.CHR and then
click on the 2 button in the PeakSimple
toolbar. A second chromatogram channel is now open in the PeakSimple window.
2. Once the second channel is open select
File from the PeakSimple menu bar and
then click on Open. The Load chromatogram file window will open up displaying a list of files to load. Select chromatogram FID602.CHR to load and then
select the 2 channel radio button to load
the chromatogram in the second channel.
3. Once FID602.CHR is open in the second channel right click using the mouse
on the first channel and select Channel
Details from the list of options.
4. After the Channel 1 details window appears on the screen locate the Overlay
data in channel check box and select
it. Look to the dialogue box to the right
of the Overlay data in channel check
box and insert the number 2 in place of
the 1. Click on OK with the mouse cursor to exit the Channel 1 details window.
5. The chromatogram FID602.CHR is now
in place overlaid on top of chromatogram 602.CHR in channel 1. Chromatogram 602.CHR is in black while
FID602.CHR is in red.
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Printing a Chromatogram
1. To print a chromatogram first open
chromatogram 602.CHR. Once the
chromatogram is open select File
from the PeakSimple menu bar and
then select Print from the drop-down
menu.
2. The Print window will open and will
allow the user to customize the printing of a chromatogram. Click on the
Format button for the Print header to
open up the Header format window.
Add or delete any information in the
window by clicking on the fields and
inserting the desired information. Click
on the OK button when all the desired
information is inputted to close the
window.
3. In the Print window click on the Format button for Print chromatogram to
open up the Chromatogram format
window. Locate the Chart speed dialogue box and insert the number of
inches each minute on the chromatogram will take up when printed (for a
nine minute run try 0.50 inches per
minute). After the Chart speed is entered click on OK to exit the window.
4. In the Print window locate the Print
report check box and click on the Format button to its right.
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5. Once the Report format window is
open click on External in the Available dialogue menu (on the left) and
then click with the mouse cursor on
the right facing arrow button to add
External to the Selected dialogue
box (on the right). After External is
added to the Selected dialogue box
click on Units with the mouse cursor
and click on the right facing arrow button to add Units to the Selected dialogue box. Click on OK with the
mouse cursor to exit out of the Report
format window.
6. Select Print in the Print window to
print the chromatogram or click on OK
in the Print window to exit the window.
Exporting to Excel
1. In the PeakSimple toolbar click on the
Results window button to open up
the Results window. Once the Results window is open click on the
Copy button to copy the results data
to the Windows clipboard.
2. Make sure Microsoft Excel is loaded
on the computer. If Excel is not loaded
you can copy results data and chromatograms to Microsoft Word or
PowerPoint. Open up Microsoft Excel
by clicking with the mouse cursor on
the Start button in the bottom left of
the Windows screen and then Programs and then Microsoft Excel in
the Windows Program menu.
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3. Once Excel is opened select Edit
from the Excel menu bar and then
Paste from the drop down menu. The
results data is now placed into the columns and rows of Excel. Using the
mouse cursor, select a box to the right
of the results data in the Excel
spreadsheet. Go back into the PeakSimple program and hit Close to exit
the Results window.
4. Right click with the mouse cursor anywhere on chromatogram 602.CHR
and select Copy picture from the resulting menu. Go back into Excel and
select Edit from the Excel menu bar
and then Paste from the drop down
menu. The PeakSimple chromatogram will now be displayed next to
its results data in the rows and columns of Microsoft Excel.

This concludes the PeakSimple Basic Tutorial.
An Advanced Tutorial can be obtained by going to:
www.srigc.com
If you have questions or would like to place an order, call:
(310) 214-5092
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Installing PeakSimple from the CD or USB
thumb drive:
A. Start the Windows operating system in use
on your computer. (Windows XP, Vista, or 7)
B. Insert the CD or USB thumb drive into the
computer.
C. Open My Computer and open either
the CD or thumb drive.

Installing PeakSimple from software download:
A. Start the Windows operating system and use an
online browser to access www.srigc.com.
B. From the menu on the left hand side of the
screen select Download PeakSimple and then
download the latest version. Windows XP and
some Vista computers need to download the 32bit version, other Vista computers and Windows
7 need to download the 64-bit version. If you are
unsure, right-click on My Computer then select
Properties in order to determine what bit operating system you are using.

D. Double-click on the Setup.exe file. Make
sure to select the right version of PeakSimple to install (32– or 64-bit). Windows XP
and some Vista computers need to install
C. Save the file to a temporary folder and doublethe 32-bit version, other Vista computers and
click on the setup file when it is finished
Windows 7 need to install the 64-bit version.
downloading, or, just click Run to install PeakIf you are unsure, right-click on My ComSimple without saving the setup file.
puter then select Properties in order to determine what bit operating system you are
D. Follow the onscreen instructions provided by the
using.
installation wizard.
E. To complete installation follow the onscreen
instructions provided by the installation wizard.

E. For instructions on loading the driver, please
refer to the Quick Start Document located in the
PeakSimple folder or on the www.srigc.com
website.

F. For instructions on loading the driver, please
refer to the Quick Start Documents located
in the PeakSimple folder or on the
www.srigc.com website.
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Manual Integration
1. To manually integrate the PeakSimple baseline in a chromatogram use the manual integration tools found in the manual integration toolbar. To open the
manual integration toolbar first
have chromatogram 602.CHR
and component file 602.CPT
loaded and then select Edit from
the PeakSimple menu bar. From
the drop down menu select Manual integration with the mouse
cursor. The manual integration
toolbar will now be displayed on
the left-side of the PeakSimple
screen.
2. Use the None integration tool to add
the area of the smaller peak to the
area of the Solvent peak. First, zoom
in on the solvent peak, the smaller
peak to its right, and their baselines.
Once the chromatogram is zoomed in
select the None integration tool from
the manual integration toolbar. With
the None integration tool selected
click once, using the left mouse button, on the valley between the solvent
peak and the smaller peak.
3. Use the Drop integration tool to drop
the baseline from the valley of the two
peaks to an existing baseline. To drop
the baseline select the Drop integration tool from the manual integration
toolbar. Using the mouse cursor, click
on the valley between the solvent
peak and the smaller peak to drop the
baseline.
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4. The Based integration tool raises the
baseline to the valley between two
specified peaks. With the baseline
dropped, click on the Based integration tool button and then click on the
valley between the solvent peak and
the smaller peak to its right to raise
the baseline to the valley.
5. The Lead skim integration tool allows
a peak’s area to be skimmed off of the
leading edge of another peak. To use
the Lead skim tool first unzoom off of
the solvent peak and the other smaller
peak and then zoom in on the Chlorobenzene peak, the Ethylbenzene
peak, and the baseline. After the chromatogram is zoomed click on the
Lead skim integration tool button and
then click on the valley between the
two peaks with the mouse cursor.
6. The Trail skim integration tool is similar to the Lead skim tool except a
peak’s area is now skimmed off of the
trailing edge of another peak. Select
the Trail skim tool button from the
manual integration toolbar and then
click on the valley between the
Chlorobenzene and Ethylbenzene
peaks with the mouse cursor to see
the Ethylbenzene peak skimmed off of
the Chlorobenzene peak.
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7. The Lead horizontal tool constructs
the baseline horizontally for the leading peak while the trailing peak’s
baseline stretches from the horizontal
line to the next valley. Unzoom off of
the Chlorobenzene and Ethylbenzene
peaks and instead zoom in on the Solvent peak, the smaller peak to its
right, and the baseline. Click on the
Lead horizontal integration tool in the
manual integration toolbar and then
click, using the left mouse button, on
the valley between the solvent peak
and the other smaller peak.
8. The Trail horizontal integration tool
drops the baseline horizontally for the
trailing peak while the lead peak’s
baseline stretches from the horizontal
line to the previous valley in the chromatogram. After selecting the Trail
horizontal tool in the manual integration toolbar click with the mouse cursor on the valley between the two
zoomed in peaks.
9. The Inhibit tool ends the baseline after
a valley effectively inhibiting a peak’s
area from being counted with the rest
of the chromatogram. To use the Inhibit integration tool select the Inhibit
tool button from the manual integration toolbar and click on the valley of
the Solvent peak and the smaller peak
to its right.
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10.The Rubber Band tool is used to
manually draw the baseline in a chromatogram. To use the Rubber Band
tool first scroll the X-axis scrollbar all
the way to the left to 0.000. Select
the Rubber Band tool from the manual integration toolbar and draw a
line from the valley between the Solvent peak and the small peak to its
left to the valley between the smaller
peak to the right of the Solvent peak
and the peak to its right.
11. To undo a change made to the baseline of a chromatogram with the manual integration tools use the Undo
button found in the manual integration toolbar. To undo the changes
made to the baseline using the Rubber band tool click on the Undo button with your mouse cursor. All
changes made to the baseline will
now be undone.
12. The Reverse tool allows the inverting
of a peak in a chromatogram. First
unzoom off of the Solvent peak and
the smaller peak to its right and then
select the Reverse tool from the
manual integration toolbar and click
and hold the left mouse button while
the area of the chromatogram you
want to reverse is dragged over with
a black box. Let go of the mouse button when the desired area is selected
to reverse the orientation.
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13. The Zero tool is used to set the
value of the data line at a selected
point and following in the chromatogram to zero. First undo the
changes done to the chromatogram
by the Reverse tool by reopening
602.CHR in the PeakSimple menu
bar. Note: Changes made to a chromatogram by the Reverse tool and
the Zero tool cannot be undone with
the Undo tool. Once the file is reopened click on the Zero tool and
click anywhere on the baseline between the Ethylbenzene peak and
the two peaks to its right with the
mouse cursor to set the data line at
zero.

Creating Component Tables
1. To create a component table from
scratch open up a second channel in
the PeakSimple window by clicking on
the Display Channel 2 button in the
PeakSimple toolbar. Once the second
channel is open click on File and then
Open to get to the Load chromatogram file window. Select the Channel 2 radio button and then file
FID602.CHR from the list of files to
open the file in channel 2. Click OK
with the mouse cursor to load the file.
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2. In channel 2 locate the second tall
peak from the left and right click on it
with the mouse cursor. From the resulting menu select Add component
to add a retention window bar to the
peak. Once again right click on the
peak and select Edit component
from the menu to open up the Component details window.
3. Once the Component details window
is open locate the Peak number dialogue box and add the number 1. Immediately underneath the Peak number box is the Peak name dialogue
box. In the Peak name dialogue box
input benzene to name it. Locate the
Units box and put ppm to make the
units parts per million. Locate the In
case of multiple peaks options box
and select the radio button for Show
largest peak only. Click on OK with
the mouse cursor to close the window.
4. Go to Edit in the PeakSimple menu
bar and then Channels from the resulting menu. The Channel controls
window is now open. Locate the
Channel 2 options box and the Integrate checkbox. Check the Integrate
checkbox and then click on OK with
the mouse cursor to close the window.
The peak in the second channel
should now identify itself as benzene.
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5. Locate the large peak to the right of
the benzene peak in the second channel. Right click and then select Add
component to add a retention window bar to the peak. Right click again
and go to Edit component to open up
the Component details window.
Change the Peak number to 2, the
Peak name to toluene, the Units to
ppm, and the In case of multiple
peaks options box to Show largest
peak only. Click on OK with the
mouse cursor to exit the window.

6. Right click anywhere on the second
channel and select Components from
the list of options. Once the Channel 2
components window is open make
sure all the data is correct and then
click on Save to save the Component
data to disk. Name the file Ctable and
then click on OK to close the window.
An unlimited number of component
windows may be added to the component table.
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Temperature Programming
1. To modify the temperature programming in PeakSimple right click anywhere on the chromatogram and
choose Temperature from the drop
down menu. This will open up the
Temperature control window.
2. In the Temperature control window
select Add from the group of buttons.
The Temperature segment details
window will open allowing the addition
or modification of the temperature programming. Enter the numbers shown
in the picture to the right in the appropriate fields. Click on OK to close the
window and go back into the Temperature control window.
3. Select the Add button from the Temperature control window to open up
the Temperature segment details window once again. Leave the Initial temperature at 200 and insert a 1 in the
Hold for dialogue box. Change the
Then ramp at dialogue box to 5 and
the Until temperature is box to 250.
Click on OK to close the window and
to see the new temperature data
added to the temperature box. Click
on OK to close the window.
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Events Table
1. To modify the Events table in PeakSimple open up chromatogram
602.CHR and zoom in on the benzene
peak, the smaller peak to its right, and
the baseline. Right click anywhere on
the chromatogram and select Events
from the drop down menu. Doing this
will open up the Events window where
specific events can be added to the
chromatogram.
2. Click using the mouse cursor on the
Add button to view the Event details
window. A list of event types are available with their radio buttons to either
select or deselect the event. Note:
The event types to the left of the window are real-time and thus will only
affect the chromatogram when A/D
hardware is connected. The event
types to the right are concerned only
with integration and their changes will
be immediately evident after returning
to the main screen and selecting Reintegrate from the Edit menu bar.
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3. In the Event details window locate
and select the relay G radio button
with the mouse cursor and then locate
the Event time dialogue box and enter .1 in the box. Click on OK to exit
the window. Note: The relay might be
used to actuate a valve when hardware is connected. The event type will
now be added to the Events table. Select the Add button and now locate
and select the Zero event type radio
button. Leave the Event time box at
0.000 and once again click on OK to
exit the window and add the event to
the Events table. Note: The Zero
event auto-zeros the detector signal at
the beginning of the run. Click on the
Add button again and select the Integration-Based immediate radio button in the Event details window and
input 1.86 in the Event time dialogue
box. Select OK to exit the window.
4. There are now three events in the
Events table. Click on OK to exit the
Events window and then hit the Enter
button on the keyboard to reintegrate
the baseline according to the events
in the Events table. Notice that the
baseline is connected to the data line
at 1.86 minutes.
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Overlay and Subtract
1. To overlay one PeakSimple chromatogram on top of another chromatogram open up a second channel in
the main screen and load chromatogram 602.CHR in the first channel
and chromatogram FID602.CHR in
the second channel. Right click anywhere in the first channel and select
Channel details from the drop down
menu.
2. In the Channel 1 details window locate the Overlay data in channel
checkbox and check it and then input
a 2 in the dialogue box to the right.
The chromatogram in channel 2 is
now overlaid on top of the chromatogram in channel 1. The overlay appears in a different color.
3. Right click anywhere on the first channel and select Overlay adjustment
from the drop down menu. In the
Overlay adjustment window locate the
Factor scroll box in the X box. Experiment scrolling the X factor up or down
to shift the overlaid chromatogram to
its right or left. Locate the Factor scroll
box in the Y box and experiment
scrolling the Y factor up or down to
move the overlaid chromatogram up
or down. Click on the Close button to
close the window.
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4. To subtract a chromatogram in one
channel from another channel, right
click using the mouse cursor on channel 1 and select Channel details.
From the Channel 1 details window
deselect the Overlay data in channel
checkbox and then click on the OK
button to exit the window.
5. Go to the Edit menu bar and select
Subtract/Add channels from the
drop down menu. In the Subtract/add
channels window make sure the Subtract radio button is selected and that
channel 2 is being taken from channel
1. Click on the OK button to make the
changes take effect and have channel
2 subtracted from channel 1. The normal way to use this feature is to subtract a drifting baseline from a chromatogram.

Results Log
1. Open chromatogram 602.CHR in the
PeakSimple main screen and then select the Results button from the PeakSimple toolbar. In the Results window
click on the Clear results log button
at the bottom of the window. Click on
Yes from the resulting window to clear
the results.

Page 13
49 (of 85 ) 2006-Update

50

PeakSimple Advanced Tutorial
Version 4.17, September 2012
2. Locate the Add to results log button
and click on it three times to add the
results on the screen to the Results log
three times. Click on the Show results
log button to view the results log in the
Windows Notepad. Exit the Windows
Notepad program by selecting File from
the menu bar and then Exit.
3. In the Results window locate the Copy
results log button at the bottom of the
window and click on it with the mouse
cursor (don’t confuse the Copy button
with the Copy results log button). Open
up Microsoft Excel (or if Excel is not
loaded Microsoft Word or PowerPoint)
and select Edit from the menu bar and
then Paste to copy the results log to
Excel.
4. Go back into PeakSimple and close the
Results window by selecting the Close
button. Right click using the mouse cursor on the chromatogram and select
Postrun from the drop down menu to
open the Post-run actions window.
From the window locate the Add to results log checkbox and add a check to
the box. By selecting the Add to results
log checkbox all results from data
analysis will automatically be added to
the results log after the run is done.
Click on OK to exit the window. In this
way a summary of many analyses can
be automatically created and then exported from PeakSimple.

This concludes the PeakSimple Advanced Tutorial
Further documentation can be obtained by going to:
www.srigc.com
If you have questions or would like to place an order call:
(310) 214-5092
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PeakSimple update tips for
serial ( non-USB )interfaces

If you are updating to the latest
version of PeakSimple software
and have a serial interface to your
GC or data system then you will
have to enter the correct board
type in Peaksimple’s Edit/Overall
screen.

This is a
serial cable

PeakSimple now support four different A/D boards,
two serial types and
two USB types.
Enter the board type
and the comport
here in the Edit/
Overall screen.
Also enter the comport number in the
field immediately
below the board
type.
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Copying Data To Excel from PeakSimple
December 2016

The calculated results from the chromatogram on the screen are shown in tabular format in the View/Results screen.
Click the COPY button to copy the results table as a CSV ( comma separated
variable ) file to the Windows clipboard.

From Excel, select a cell, right click and
then left click PASTE.

The results table from PeakSimple appears in Excel.

SRI Tech Support: 310-214-5092
www.srigc.com

Copying Data to Excel December 2016
Page 1
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Copying Data To Excel from PeakSimple
December 2016

Sometimes you want to copy the results of
more than one chromatogram into Excel.
For example, you may be running a series
of tests and want to get the results from all
the tests into Excel.
Click the button in the Results screen labellled SHOW RESULTS LOG.

If there is already a RESULTS LOG it will
look something like this. Each line in the
results log has a time and date stamp plus
the same information as in the results table, except the data is stretched out in one
long line for each analysis. Ideally the
peak information is perfectly lined up in
columns as shown.
If there is not already a results log, then
you can add the results table to the log by
clicking the button labelled ADD TO RESULTS LOG also at the bottom of the Results screen.
The results from each analysis can be
added to the results log automatically at
the end of each run by checking the box
in the Postrun screen labelled ADD TO
RESULTS LOG. You can also define the
name of the results log file. It defaults to
CH1.log for channel 1.

SRI Tech Support: 310-214-5092
www.srigc.com

Copying Data to Excel December 2016
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Copying Data To Excel from PeakSimple
December 2016
Click the button at the bottom of the Results
screen labelled COPY RESULTS LOG.

This copies the entire results log to the Windows clipboard.

In Excel click Paste and the results log loads
into Excel.

You can also Load the results log from Excel
by clicking File/Open ( in Excel ) then navigating to the PeakSimple folder to load
CH1.log or whatever the name of the log file
is.

If the columns of numbers are not perfectly
lined up, make sure the box in the results
screen labelled UNDETECTED PEAKS ALSO
is checked. This reserves a space in the log
file for each peak even if it is not detected and
has zero area.

SRI Tech Support: 310-214-5092
www.srigc.com

Copying Data to Excel December 2016
Page 3
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Using the E-mail feature of
PeakSimple version 3.84 and later
PeakSimple version 3.84
and later include a e-mail
feature which allows the
user to send a e-mail containing the results of the
chromatogram at the end
of every run, or only when
an error condition is detected.
The e-mail send to address is entered in the
Edit/Overall screen by
clicking the Email Settings
button.
Most of this information can be
found by clicking Tools/Settings
and then Accounts and then Edit in
your e-mail application.

The “username” and password are
listed here

The outgoing mail server ( SMPT )
is listed here.

In the “Send To” box enter the email address you want the e-mail
sent to.
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Using the E-mail feature of
PeakSimple version 3.84 and later
In the Postrun box for each
channel you can select whether
to send an e-mail:
Never ( No )
On Alarm Condition only
Always

Set the Alarm conditions in the
Components/Details/Alarm
Details screen.
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PEAKSIMPLE SOFTWARE
Events
Events
PeakSimple gives you control of up to eight independent external events, or hardware events. A hardware
event is the operation of a device external to the data system but integral to the analytical run. A
hardware event can be a valve rotation, opening or closing a split vent, activation of an autosampler
sequence, or operation of an electrical switch at a precise moment during the run. PeakSimple also
gives you control over a comprehensive list of non-hardware events, such as integration events, data
system signal control events (zero, reverse), and DOS command events. Events are controlled
automatically with Event tables that use the system clock, which starts at 0:00 with each run. Using
PeakSimple Event tables enhances the reproducibility of the resulting chromatograms by ensuring
repeatable actuation of devices from run to run.

The eight timed event output signals are called
relays, and are named A-H. For example, when
an SRI GC is equipped with a 10-port gas
sampling valve, its rotation/actuation is
controlled by a relay: relay OFF = valve in the
LOAD position; relay ON = valve in the
INJECT position. The relay assignments for
any given instrument are printed on the side
panel (right hand side for GCs, left-hand side
for HPLCs).
This list of assigned relay functions is printed on the side
of a TO-14 GC customized with 4 sample solenoid valves.

Users may manually control any relay event, either during the run or while in
stand-by mode, by using the Relays/pump window. Click on View and choose
Relay/pump window. In this window are eight buttons representing the relays
with the appropriate letter. Activate a relay by clicking on its letter; it becomes
highlighted to show its ON status. You can also toggle the relays from the
keyboard by holding the control key (Ctrl) while pressing the letter of the
relay: Ctrl+C, Ctrl+H, etc.

57 (of 85 ) 2006-Update

58

PEAKSIMPLE SOFTWARE
Events
Event Tables
You can open the
events table window
from the Edit>
Channels screen.
Click on the Events
button for channel
1. Or, right-click in
the chromatogram
window and select
Events from the popup menu.
The event table window will open, either empty,
or with whatever .EVT file was saved with the
current control file (DEFAULT.CON, unless
you have specifically opened another). At the
bottom of the events table window there are
several buttons for you to access event features.
Each channel has its own event table because
of the signal processing type events that are
available, such as Zero, Reverse, and
Integration events. Hardware events may also
be activated from any channel. SRI
recommends entering hardware events only in
the channel 1 event table to avoid confusion.
Click on the Add... button to add an event to the
event table. The Event details screen will open,
where you select the event and enter the time at
which you want it to occur.
Click on an existing event in the event table to select and
highlight it, then click on the Change... button to edit the
selected event. You can also simply double-click an event to
open the Event details screen, from which you can edit any
selected event.
Click on the Remove button to delete a selected event from
the events table.
Type in your custom event descriptions.

Click on the Describe... button to customize any or all of your
eight relay (hardware) event descriptions.
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PEAKSIMPLE SOFTWARE
Events
Click the Load... button to open an existing event table. PeakSimple will open the program directory
and display all .EVT files.
Click Save... to save the current event table shown in the window.
Click Clear to remove any and all events and .EVT files from the event table window (but not from the
hard drive). PeakSimple will prompt you for confirmation before proceeding to clear the event table.
Click the Print button to send the current event table to the printer through the Windows print manager.
Click the Shift... button to shift the
sequence of events following the selected
event forward or backward in time.

In this example,
we are shifting the
highlighted event
forward 2 minutes.

Now the selected event takes place at 7.00
instead of 5.000; all subsequent events have
also been shifted forward two minutes.

The Shift... button saves you having
to re-type the entire event sequence.

Click the OK button to exit the events table window.
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PEAKSIMPLE SOFTWARE
Events
The Event details screen opens when you click the Add... or Change... buttons, or when you doubleclick any single event in the list. In the Event details screen are listed all the events you can enter into
an event table. Starting on the left, the eight relays are listed, followed by non-hardware events. Hold
your mouse cursor over any event to read its ToolTips description.
There is a checkbox labeled “On” to the right of the hardware events list. When the event is turning
ON a relay, make sure this box is checked. Uncheck the box when the event is turning OFF a relay.
Even though they control the same relay, ON and OFF are separate and distinct events in the timetable.
On the bottom left of the Event details window is the Event time field. Enter the time at which you
want the event to occur here. Typically, PeakSimple has a lot of tasks to perform at the beginning of an
analytical run. Therefore, SRI recommends that you enter the first hardware event no earlier than
0.100 minutes (6 seconds).

Hardware events are the
first 8 listed in the Event
details window...

...followed by non-hardware
events.

Enter the time at which
you want the selected
event to occur.

Enter DOS path and filename here

PeakSimple also permits you to automatically execute a DOS command during the analytical run
using an event table. A DOS command is the same as running an executable file. You may use this
function to launch a macro to copy, rename the preceding file so the next file may be updated into a
spreadsheet, or to copy the chromatogram data and results file onto a floppy or hard disk drive other
than the destination to which it was originally saved. A DOS command may be executed at any time
during the analytical run by typing in the DOS path and the filename of an .EXE, .COM, or .BAT file,
and the time the event is to occur. To add a DOS command event: click the radio button next to
“Command,” and type in your DOS path and executable filename. Example: C:\Excel\Macro1.bat
Next, type in the time during the run at which you want the command to be activated in the form field
labeled Event time. DOS events that require prolonged disk access should be executed after the run,
using Post-run actions for channel 1.
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PEAKSIMPLE SOFTWARE
Events

You can choose to reset all eight relays at
the end of the run by clicking Edit>Overall
and checking the box in the lower left
corner.

This option will return the relays to their
default position—OFF.

In some cases, a user may not want to reset the relays at the end of the run. For instance, when using
our TO-14 Air Concentrator, users leave the gas sampling valve in the INJECT position at the run’s
end. This sweeps clean the trap and column, preparing the system for the next sample. In this case, the
user would have an event table to turn OFF the valve relay and return it to the LOAD position sometime
after the run has started. Therefore, such users would deselect the “Reset relays at end of run” option.
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Performing Internal Standard Calibration using
PeakSimple version 3.51
For this example, we will create a 5 point
calibration curve for Glycerin using
Butanetriol as the Internal Standard.
Load the level 1 chromatogram into
channel 1. ( File/Open )
Identify the Butanetriol Internal Standard
peak by using the mouse to point to the
Butanetriol peak. Click on the right
mouse button, then click Add Component.
Point to the Butanetriol peak again, right
click, then select Edit Component ( you
can just double-click the peak as a shortcut ).
Enter the Component Details especially
note that Peak Number is 2 and the Internal Standard is 1000. The Internal
Standard is the amount of Butanetriol
which you know to be in the sample. In
this case it is 1000 ppm.

Go through the same process for Glycerin. Note that the peak number is 1,
that the Internal Standard box is left at
0.00, but the Internal Standard Peak box
is set to 2. By entering the 2,
PeakSimple knows that peak
number 2 should be the Internal Standard for this peak
( Glycerin ).

1
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Performing Internal Standard Calibration using
PeakSimple version 3.51

Right click anywhere on the chromatogram screen and select Components

Notice in the Components window that
the number 2 is listed in parentheses
next to the peak number 1.
This is how PeakSimple reminds you
that peak number 2 ( Butanetriol ) is the
Internal Standard for peak number 1
( Glycerin ).
It is a good idea at this point to save the
Component table. Click Save and enter
a filename ( BioDiesel.cpt for example )

Return to the Chromatogram screen,
point to the Glycerin peak with your
mouse and right click. Select Calibrate
Glycerin from the menu.

2
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Performing Internal Standard Calibration using
PeakSimple version 3.51
A screen will appear offering to let you
copy a Template Calibration file. This is
a convenience when creating many calibration curves since you can make a
Template calibration curve once and
avoid typing in the same information
over and over for each similar curve.
We don’t need to do this for this
example, so just click No.

Another screen appears which allows
you to specify the calibration level ( i.e.
Level 1, Level2, Level 3 etc. ).
Since we do not as yet have a curve,
click the radio button for Level 1 and
then OK.
PeakSimple then displays the blank calibration curve

3
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Performing Internal Standard Calibration using
PeakSimple version 3.51
Enter the amount of Glycerin in the
Level 1 standard ( the chromatogram on the screen ). In this example, the Glycerin is at 100ppm, so
enter 100 in the top left cell of the
table.
Then click on the button labeled
Accept New.
The ratio of the Glycerin peak area
divided by the Butanetriol peak area
in then entered automatically in the
cell immediately to the right of the
100. A single point curve is also
drawn on the graph.
It will save time if you enter the remaining Level 2, Level 3 , Level 4
and Level 5 amounts along with estimated ratios.
These are just
approximately
correct numbers
and will be replaced when we
actually calibrate Level2
through Level 5.
As you do this
you will see the
multiple points
plotted on the
graph.
Save the curve
by clicking Save

4
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Performing Internal Standard Calibration using
PeakSimple version 3.51
Open the Level 2 chromatogram ( File/
Open ) or inject the Level 2 standard
and allow the run to end. ( you can’t
calibrate until the run is over ).
Point to the Glycerin peak and right
click. From the menu select Calibrate
Glycerin.
This time when the Recalibration
screen appears, select the Level 2
radio button.
When the Calibration curve screen appears, click Accept New and the ratio
between the
Level 2
Glycerin and
Butanetriol
Internal
Standard will
be automatically inserted in the
Level 2 cell.
Note that the
old value
( the estimated value
we entered
previously )
is not lost
but is shifted
one cell to
the right.

5
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Performing Internal Standard Calibration using
PeakSimple version 3.51
Follow the
same procedure for
Level 3, 4
and 5.
The actual
ratios replace the
previously
entered estimated values to produce a real 5
point calibration curve

Next inject a
real sample
( not a calibration standard ) and
verify that
the Result
screen displays a logical answer under the Internal column.
Note that the Butanetriol Internal
Standard peak is not calibrated and
shows a 0.00 result.

6
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Enabling the Pressure program on the
SRI 8610C GC
The A/D
board is
mounted
along the inside right side
of SRI
8610C, 310C
and 410 GCs.

The A/D board is labeled Analog Out 1,2
and 3 if your A/D board is a model 302 6
channel USB type.
The 302 board has 3 analog outputs.
Analog output #1 is used to control the
oven temperature program. Analog outputs#2 and 3 are normally left unconnected to anything.
All other A/D boards ( model 333, model
202 and model 203 ) are labeled TP1
( temperature program one ) or TP2
( temperature program two ). These
board only have two analog outputs.
Locate the wire which is labeled Carr
Prog ( carrier program ). This wire will
be tucked under the A/D board and insulated with a piece of colored tape.
Connect the Carr Prog wire to Analog
output#2 ( or TP2 ) to enable the program in PeakSimple’s Channel Two to
control the carrier gas pressure. If you
prefer, you can connect to Analog output#3 in which case the program in
PeakSimple’s channel 3 would control
the carrier gas pressure.
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Enabling the Pressure program on the
SRI 8610C GC

Set the “Control By” radio
button in PeakSimple’s
Channel Two details screen
to “Pressure”.

Exit the Channels menu
and then re-enter. You
will see that the Channel 2
Temperature button is
now labeled Pressure
Enter a pressure program
which is appropriate for
your analysis.
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Enabling the Pressure program on the
SRI 8610C GC

Using a screwdriver adjust the
Carrier Local Setpoint to 000. The
Total Setpoint will now display
whatever Channel Two pressure
program is set to.
The Total Setpoint is the sum of
the local setpoint ( the screwdriver
setpoint ) and the remote setpoint
( the setpoint from PeakSimple ).
If the local setpoint is set to something other than 000 it will add to
the Total Setpoint. So if the local
setpoint was 5 and the remote setpoint was 5, the Total Setpoint
would read 10.

When the GC is first turned on
and before PeakSimple establishes communication, or if
Channel Two is not activated the
remote setpoint defaults to
45psi.
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PEAKSIMPLE SOFTWARE
Autosampler Queue

The Autosampler Queue is the most powerful and complex function of PeakSimple, and requires a
throrough understanding of the software’s features. If you are at the beginner level, you should not
attempt to use this feature.
The Autosampler Queue allows a list of control files to be run automatically in sequence. PeakSimple
uses control files to save the operating settings of specific methods. Once all the user-definable
parameters have been set, they can be saved in a control file for future use. Control files contain .CAL,
.CHR, .CPT, .EVT, .GRA, and .TEM files, and every other user-modifiable parameter. You must begin
with control files already made, to load into the Autosampler Queue. You must create or modify a
control file for each vial.

Each control file in the list must have a unique name, even if it is identical to others. It is helpful to
include a number in the name of each control file that corresponds with its place in the list; for example:
Vial01.con, Vial02.con, Vial03.con, etc. The control file(s) you wish to use in the Autosampler Queue
must be saved in the PeakSimple application directory.

To open the Autosampler window, click View, then choose Autosampler.
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PEAKSIMPLE SOFTWARE
Autosampler Queue
Autosampler Queue Buttons
There are several buttons on the right-hand side
of the autosampler window. The “Close” button
is for closing the Autosampler window. The
“Add” button is for adding control files to the
queue. Click the “Add...” button. Browse to the
PeakSimple application directory, and select a
control (.CON) file to place in the queue.
PeakSimple will place the file in the queue above
the .CON file you have highlighted, or at the
end of the list if “<end>” is highlighted (default).

Since you can only add one control file
to the queue at a time, it can get tedious,
especially if you are using multiple
instances of the same control file.
When this is the case, use the “Add...” button
to add your master control file to the queue,
then click on the “Edit all” button to open the
control file attributes spreadsheet, shown below.
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PEAKSIMPLE SOFTWARE
Autosampler Queue
Highlight the control file that is your master, or the one that is to be repeated, and click the “Add
copies” button. In the window that pops up, enter the number of copies you wish to make, and check
the “Increment data filename for each copy” box. PeakSimple will save the copied control files in the
application directory.

The following example is for a 10 vial liquid autosampler for GC. In this example, we have three
control files. The third control file is the one we will copy.

We will copy Vial3.con 7
times for a total of 10 control
files, as shown in the Edit all
spreadsheet below.

We now have Vial[1-10].con
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Autosampler Queue
The “Add multiple” button is for batch reprocessing. Batch reprocessing allows you to reprocess the
raw data through a designated control file. This is useful in the event of a mistake or omission, or when
header/comment info needs updating. The “Batch reprocessing mode” checkbox to the left of the
“Add multiple” button must be selected. Then, when you click the “Add multiple” button, you will be
prompted to select a control file:

When you select a control file, you will
be prompted to select one or more data
files (.CHR or .ASC) that you want
reprocessed with that control file:

The data files will then be listed in the
queue with their corresponding control files.
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Autosampler Queue
To delete a control file from the autosampler queue, highlight it and click the “Delete” button. If no
control file is highlighted, the last file in the list will be deleted when this button is clicked.

Click the “Load...” button to open a
pre-existing autosampler queue file
(.QUE) in the autosampler window.

Click the “Save...” button to save
the list of control files in the
autosampler queue as a .QUE file.

Click the “Clear” button to erase
the entire autosampler queue.

When you click the “Edit...” button
after highlighting a control file in the
queue, the control file is loaded and a
screen opens in which you can edit
common parameters. To edit other
parameters of the control file, just
close the “Edit” screen, then click on
the PeakSimple window behind the
Autosampler window to make the
changes. Click File>Save control file
when you are finished editing.
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Autosampler Queue
Click on the “Edit all...” button to open the control file attributes spreadsheet. The Edit all spreadsheet
is a powerful tool for managing your control files; it allows you to edit any or all of the control files in
the autosampler queue.

You can highlight an
entire column to
change...

...Or make changes in
individual cells.

There are ten buttons on the lower left corner of the “Edit all” spreadsheet.
Click on the “Close” button to close the spreadsheet window with a prompt to save your changes.
To close the spreadsheet window without saving any changes, click the “Cancel” button.
Click the “Add...” button to add a control file to the queue and spreadsheet.
Use the “Add copies...” button to add copies of a selected control file to the queue.
Click the “Delete” button to remove a highlighted control file from the queue. If no control file is
highlighted, the last file in the list will be deleted when this button is clicked.
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Autosampler Queue

Use the “Fill...” button
after highlighting a
vertical column in the
spreadsheet to fill the
cells with new text. To
highlight a vertical
column, click in the
uppermost cell you want
to include, then drag
your cursor down to the
last cell you want
included.

Click the “Update control files” button to save all the changes made to the control files in the
spreadsheet.

Click the “Format...” button to specify which
control file parameters are displayed in the
spreadsheet. Some commonly edited control
file parameters are included by default, but the
user may format the “Edit all” spreadsheet as
desired. For example, if you have one detector,
you can format the spreadsheet to display the
parameters for one channel instead of all six
(regardless of your GC and data system specs,
PeakSimple always has six channel capability).
To add a column to the spreadsheet, highlight
the header in the list on the left, then click the
double right arrow (>>). The header will appear
in the list on the right, which is the list of
selected features/column headers. To remove a
header and column from the spreadsheet,
highlight it in the “Selected” list, then click the double left arrow (<<).

Highlight a control file and click the “Load now” button to open it in the main PeakSimple window
for editing.
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Calibration
The calibration curve is calculated from
user-generated results obtained at several
different concentrations that span the
expected range to be encountered in actual
samples. Calibration is required for each
component you expect to be in your sample,
and for each detector you will be using in
your analysis. Once calibrations curves
have been completed and calibration files
saved, they will be included in the .CPT file.

Calibration files are shown in the components table.
They may be edited individually by highlighting one,
then clicking on the “Change” button.

It is typical to calibrate samples at the
beginning of an autosampler queue.
Remember, the calibration curve is
calculated from user-generated results
obtained at several different concentrations
that span the expected range to be
encountered in actual samples. You must
have already created your calibration curves before using the Autosampler queue.
To make the first 3 vials calibration standards:

1. In PeakSimple, click “File,” then choose “Open control file.” Browse to the application directory,
where you should already have saved the control files you want to use in the Autosampler queue.
Select the control file that you want to run first. For each channel, open the post-run actions window,
and select the “Recalibrate at level” box. Enter “1” in the box. Click “File” then choose “Save control
file.”
2. Open the second control file in the Autosampler
queue and do the same for each channel, except enter
a “2” in the box. Save the second control file.
3. Repeat the steps for the third control file, except
enter a “3” in the box. You can also edit the control
files through the “Edit all” spreadsheet in the
Autosampler queue.
In the post-run actions window, the “Recalibrate
at level ___” check box recalibrates all identified
peaks at the end of a run. The level of
recalibration, from 1 to 7, is typed in by the user.
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PeakSimple Software Self Validation

PeakSimple is SRI’s software that allows a GC to
communicate and interface
with a Windows computer
through an A/D (analog to
digital) converter. The latest version can be
downloaded for free from
www.srigc.com.

Download the validation
data package from
www.srigc.com. Place the
three files (Validation components.cpt, Reproducibility.chr, and Linearity.chr)
into a folder on your C:
drive named “Validation”
(C:\Validation).

In order to validate the PeakSimple software the user will employ
either Hardware loopback or
Software loopback, which can be
selected from the “Overall controls” menu accessible from the
“Edit” Menu on PeakSimple’s main
screen. Make sure that the
“Sample rate” is set to 5Hz.
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PeakSimple Software Self Validation
Initiate communications between
PeakSimple and the GC or datasystem. In the “Channels” Menu,
make sure that Channel 1 is active, displayed, and integrated by
checking the appropriate boxes.
Ensure that Channel 6 is displayed
and integrated.

From the main PeakSimple
screen, right-click on Channel 1
and select “Components”. From
the Components screen select
“Load” and open the “Validation
components.cpt” file from the
C:\Validation file folder. Do the
same thing for Channel 6.

Load the “Reproducibility.chr”
chromatogram into Channel 6 by
selecting “Open” from the File
menu, selecting the “6” Channel
button, and selecting the Reproducibility.chr file from the
C:\Validation folder. Hit the Open
button.
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PeakSimple Software Self Validation

In the Overall Controls menu select “Software loopback” and hit
the OK button. Software loopback
will take whatever chromatogram
is in Channel 6 and reproduce it in
Channel 1. The data is transferred
bit for bit in real time just as if
Channel 1 is acquiring new data.

Your PeakSimple screen
should look like this. Notice
the “(LOOPBACK)” next to
the signal display in the upper right hand corner of the
screen.

Start the Validation run by
selecting “Run” from the Acquisition menu or press the
Spacebar on your keyboard.
At the end of the run your
screen will look something
like this.
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Once the run is completed compare the results of Channel 1 to
Channel 6 in order to
see how faithfully the
data was reproduced. In
this instance, the area
counts of all the peaks
are identical.

In order to calculate statistically
meaningful measurements (i.e.
standard deviation), several validation runs may be required. To simply the process, the user can automate the validation runs by opening up the “Postrun” menu from the
Channels menu. In the Postrun
menu ensure that the “Save file
as” box is checked and given a
name and the “Auto-increment”
box is checked. Check the “Add to
results log” box and give it a name.
Finally, check “Restart run after”
and enter a time and the number
of runs that you would like to have
it perform. The data from the runs
will be saved to the .LOG file
where it can be viewed or easily
exported to a data management
program like Excel.
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To test for linearity rather
than reproducibility, simply
perform the same process as
previously outlined, except
this time load the
“Linearity.chr” file into Channel 6. For this chromatogram
each succeeding peak has
half the area counts of the
one before it. When you do
this the PeakSimple screen
will look something like this.
To perform Hardware loopback
validation select “Hardware loopback” from the “Overall controls”
menu. In general, Hardware Loopback will have more deviation than
Software loopback due to a difference in resolution (14 bits for
Hardware, 24 bits for Software).
With Hardware loopback the chromatogram in Channel 6 is played
back as an analog voltage which
Channel 1 re-acquires just like a
real chromatogram.
If you have a 333 single channel
data system (or board inside your
GC) connect a wire from ground to
the negative signal input terminal,
and another wire from the TP 1
terminal to the positive signal input
terminal. It should look like the picture to the right.
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If you have a six-channel 302 data
system (or board inside your GC)
connect a wire from ground to the
negative channel one and another
wire from the 1 analog out terminal
to the positive channel one terminal. It should look like the picture
to the right.

With the Validation components file loaded into Channels 1 and 6 and either the
Reproducibility or Linearity
chromatogram loaded in
channel 6 (in this case Linearity is loaded) start the run.

When the run is completed
compare the area counts between the two channels. As
discussed previously, you
can automate a number of
validation runs in order to
collect statistical information.
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The Reproducibility.chr and
Linearity.chr chromatograms are very clean and
easy for the software to integrate. It may be beneficial
and more realistic to use
your own chromatogram in
order to obtain your validation data. In this instance,
load a chromatogram of
your choosing into Channel
6 and perform Software
loopback or Hardware loopback as discussed previously.
Make sure to add retention
windows over the peaks
(see the PeakSimple tutorial
for adding retention windows), save the resulting
component file, and load it
in channel 1. This will allow
you to quantify the area
counts of your peaks after
each validation run.
For any validation runs, print the
chromatograms in order to have a
hard copy of your data.
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